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5. 817 INA260EVM-GUI.
INA260 JFAfEE (EVM) 52 H T 174 INA260 3= ZHEE:

FIHEREEIF & . ik EVM SRR #5ik 10A FOHLTE | Rt
JESRMEEE R A (GUI) 30, T8 o« QUI StHHRIUN S A S 25 77 52 DL % 75 B R AR 45
HURS N AR
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FraafsEH - 4> SCB/GUI %4 EVM
1. m@; INA260EVM ﬂz{ﬁﬂio ° 1j§ﬂjj SCB ﬁ@ﬂﬁﬁﬁﬁ?ﬂﬁ‘] micro-USB @?ﬁ%&%
2. T TI-SCB &SI . g
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1 PEAL LR
1155

% EVM 25 TRAKTG , FT 0 INA260 1 E R EMTERE. It EVM SCRRE PCB ik 10A [1H
Wi, IFERE TN NS5 A7 3 UL B R A ORAE 45 SR Bt 10 I F - B i (GUI)

AR FFERENET INA260 PR (EVM) B8 BiFFEREN . A& EVM FT1-5 INA260 fItERE. A
R A . SRAE LA EVM 25T RIEHE INA2BOEVM. ASCRYALEEFE . S 1R g (PCB) )5
1 5E B RN $ (BOM).

1.2 EHANE
£ 115 T EVM BN EY .. RS MMEMTotE | E5 S EERIE EMNACES (T 7= E BB R,
F11. BEHERE
LT HE
INA260EVM iR 1

FRE I EVM FEM A RMESZR T LS EHIR (SCB).
1.3 %

Ut EVM B AEX iZ a8 F RO SEA DI REREAT PPAL , AT R IR ARPE Dy AR e B AORBRLAE F , BANET XS HLE A 1% (EMC)
MRBEAT A R 6 EVM B S P ERETRI FL BB (PCB). BRI PCB #7104 EVM , EHii 23 | INA260. #/)Mif) PCB
nif SCB fxfil4s , 1% EVM 5 GUI.

1.4 BHER

INA260 & —#kE i i ThRA R SS | B 12C 1 SMBus™ 2855 111 DA K B2 BN RS 25 43 T FELBHL 2%
1%t A S R T LU RN T 2 8 AR S T YR R R A R R VS Y ( OV 2 36V ) SEBLS TRAS I . 1Z g2
— O IA] S AR/ v ) 4 W I, AT R 2 PN S FL RS N R BEL PR R . R R R B R ARSI i BEL ET e 2SR A
TREHE 25 531) P00 A5G 5 DA N AR ARR IR | R R 0 24 ] S 1 5o JBan e BEL T EIC A6 T Keellving A7 J&j

INA260 7E 12C #4210 EEAF LA 16 Nl dfetbhl . Bo78: O o e fe 3 e R R E |, T Sl B0s i ot
(ADC) &4 18] RGP IME . NE TR, Al oy ek a8 B e B B8 ( 7 vz ) MY (B4
HNE) -

s FH A 2.7V & 5.5V HYAHEE | JHFE 310 n A (S ZUAE ) HEYEHE. INA260 7E -40°C % +125°C i &
WHIEIZIT , KA 16 5l HIERUNME R ) (TSSOP) %%,

R 1-2. BIBEE
P2 b BeFihiL ADC SR | BARGWAMRE | BAKAHNR
INA260 12C 16 fir 0.15% +5mA

2 fEAE
21 REESRE
LT UWIA 0 T T B E A A EVM,

1. WG SCB , HWL—14.
a. AENH PAMB #2% | 1S PAMB #2514
2. FERULIRENFE P LB E R B4 2% | https://www.ti.com/cn/lit/zip/sbac253.
a. IEETFEILREE , JFETRERE myTHik.
b. R , BAAMIRENFEFARIL N PAMB WEhFRF , (H#H T SCB.
3. i 2-1 fiors | ¥ EVM #4825 SCB 5188
a. EBMFZRMEZA EVM I |, HS K 2-2,
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4. A F3RALR USB 45K EVM %43 PC.

a. # Micro USB Hi4i#fi A 3| SCB i #s i 4k USB #fijs: J2 .

b. Kz 5 PC.
5. {£ Chrome. Firefox 5% Safari % #%Fidid DL~ 8717 GUI : https://dev.ti.com/gallery/info/

CurrentSensing/INA260EVM_GUI/.
6. KHMI ARG IR U SRS EVM (9 GND A (J1 19511 ) .
7. FRWE AR T EEAE R B S S S EREI EVM BRI 1 S5 ek 6 11 513 84, N

IN+ AT IN - 75 SR AR .
2.2 EVM 4T
FE EVM A1 SCB #4188 ( Bkt ) i |, WKl 2-1 fisiEs: EVM.

‘36652 ﬂZi (\JN=)

R S et R
e T g1
e
_ll‘llll_ -ﬁ1 m)- I_Iiil’i_:.
2 INA260EUH
B 2-1.EVM ( £ ) ZE8:3| SCB #4188 (£ )
WRMEHZ A EVM , I 2-2 Fosif TiEss . BRGS0 R 12C fihk. GUI 2Rt 4
EVM.
Lorgesees |
= m PU"ER..T o)
2253
& 2-2. Z4> EVM %43 SCB 2%

ZHCUCF8 - OCTOBER 2024 INA260EVM 15 FEHk 3
BRI

English Document: SBOU307
Copyright © 2024 Texas Instruments Incorporated


https://dev.ti.com/gallery/info/CurrentSensing/INA260EVM_GUI/
https://dev.ti.com/gallery/info/CurrentSensing/INA260EVM_GUI/
https://www.ti.com.cn
https://www.ti.com.cn/cn/lit/pdf/ZHCUCF8
https://www.ti.com/feedbackform/techdocfeedback?litnum=ZHCUCF8&partnum=INA260EVM
https://www.ti.com/lit/pdf/SBOU307

i3 TEXAS
INSTRUMENTS

www.ti.com.cn

i

2.2.1 BRI TIERPE

INA260 £E 1% 1 7rim L FH & , Fyt A vT DU J1 B)om 4. IN+ (J1 5105 A1 6 ) A1 IN- (J1 51 3 A1 4)
FHMWA T, LA A S A 10A BRI DL N RSN 51 2 ) AT FLA A -

2211 VREEEE

BB VAL W CL T D IRERAE

1. EREBHEIELT , K IN+ AN - S 508, Wil 2-3 s, #iRRaAET 15A. RFE , W
PATE IN+ 2 IN - P31~ ok eRTREAT 20 Bk, mT DA P B In (N 51 BISRIEH2 1) VBUS i 1.

Load Current Line IN+ Load Current Line IN-

® 150 MAX
36UCHM MAX

b UEUS
IN+ 1N->

) €8 ALERT;

v -w =

)Ys D P

C lllll“

N
N

sov{@ € 2Rz
\swr e

B 2-3. IN+ F1 IN - £

)

TSN, RS (B8, EEAE ) v DA AN I IR A TR FER. FoK |, BRI S 1
KR 15A. BN, 258 EVM f3Rsi N 5155 .
EVM m] e As 4,

2. f VBUS i1 ((J1 51 2 ) EHEFI R AL S (WTRER IN+ BLIN-) .

a. WEARSRMEH] VBUS MAEIIRE |, BLiBE A H{E ADC S AR FEHIHAR S .
¥ R3] GND B (J1 51 1) .

4. HERSG LW, JFEN GUI WSS IREMH L .

w
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2.3 H#

ARG T EVM T R4 Mot
2.3.1 A IC

KA INA260 F S F: ot

U1 /& INA260 HLAEI 251 . C1 Fl C2 J&55 Mt A2y | B LA EAS MR |, A BT BRAK e 50 75 JE7E 75 B Pk
Jyte Rt e . B PR EFH2E R4 ) LED D1 H T4/~ EVM {5 i@ Ha, .

a5 ] BRI A TP - TP12 BTN, 3R, AR N , GND LA M 84 I
2.3.2 WA EH#E
AT T RNG T ERAR K R .

J1 R EER . J1 51 BT RS EtiEREm S EVM i, J1 51 2 T REsm K
VBUS. 5l 3. 4 ZHF] IN-, 51 5. 6 &EHR] IN+. AT H{EELI , IN+ T IN- ZFHA5|

2.3.3 #FHEE
AT T SR R

J2 1 J3 R 51 AT s YR 51 AR ) SCB 12 85 s EVM M 2L 51 . I3 R RIA M EVMY
SCB , 1M J2 #HEFLEMEZ A EVM. R1 A1 R2 HIME L2407 10 51 B4 P &5

SWO 1 SW1 & & T 2884410 12C Hudik. 24 EVM 5 B 2 I=H]88 ( IE SCB #&i#2% ) Bl Z A EVM i | IX
R IRGE . 2407 SCB % H|#3Al GUI & B ~A— A I YA EVM.

R8 FfE ALERT 5| IR bhz B2 | iZ 5| M & J2 A1 J3. LED D2 IR EH2s R7 F T #87~ ALERT {a] i fitk
Ko B3k J4 Fpksk SH-J1 B Bt iFF J3 SkWr - ALERT 5|5 EVM ALERT 2R % s: . X EEAMHZ A
EVM BHEH , UMEEAT E ALERT SZRH 7] AEREA EVM & 2| 551 ALERT LED.

2.4 PAMB &

WA T B B PAMB HI5] L% RER] EVM |, Ik EVM A GUI 7] L1 PAMB #5411 2% (DCO081A) #4
Fofi . K 2-4 Box 7 PAMB L5 EVM $23k 5] BAR R N A 51 Bl 1573 B AN EEAE Bk 28 7 92150 B PP s it K B
NG ST e L RS N %I & S BUEE R .

PAMB Left Header PAMB Right Header

+3v3 2 o o 2 45V 1 O o 2 GND
P2 210 o4—2GeND s 1o o2
PPO j o © g § o O g
PP1 o o o O

9 o o 10 9 o o 10

5 T° o= 5 TO O P
PQO o o O O PQ3

15 o o 16 15 o o 16
PN5 1; o © ;3 1; o O ;3 PQ1
PN4 o o O O

EVM Header

pQ1 1 O o+f—2+5v
PQO g o © g GND
Pa2 £—0 oO4—2+3v3
PQ3 o O PD2
pPO 2 o o—+—2pNs
pp1 L —10 o2 PN4

& 2-4. EVM & PAMB %3
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3 K
31 E
3.1.1 B EfFRE

TS KSR ¢ https://www.ti.com/lit/zip/sbac253. & HHEN R FHAT —XiZEE | I HFEE myTl ik
Fo iEEE, BRI RRic N PAMB IRENFERE |, BT SCB. ML C1F5 3 LB RURIZIT .exe 3L
5.

3.1.2 B

R T IR ARENRE R |, [BPFEE R iid GUI % . TaEIIEL GUI A eI U T HI 0 58 [ 1 528 SCB
Pt g o A BT HOH K GUI S 1R SEHT | 195 MR 2% 30 52 25 J5 s BT GUI

3.1.2.1 BEAER

SR AR SR R AT S B 2 [ A S R LR D SRR 2 [ W ORAETE L2 AR EVM & RE R
SCB.

1. B4, BE GUI & & ot FE A .
a. ¥4 SCB il #4@ N PC.
i ECH R EVM #ER:#] SCB.
b. Jazh GUI 3% README.md & M.
c. MR MCU C&4ab T 4FE /5% (DFU) £l , MBIl — A3l E 1, 78 “Connection Failure - No
SCB controller detected” .
i KM .
d. Wi GUI %A TR, il 2] File > Program Device...
i. Wk Program Device... #4105 S~ K G, WS 22 R A “Connect” 4241, R EHE K.
2. WIRS 1 BRI (8 Program Device $5A1AT3R K 5. ), WIF-5h¥ SCB 2% LY MCU fid & v DFU #%
o 7£ SCB =il ZH@ BAEOL T, wld@k DU N ME—J7 1 58 Ut A4
a. s
7f SCB HJ USB &7 (COM) it 1 L &K% a4 “bsl” .
b. JEILAEM
T AW, RFAFEBIIF I ARSI E.
fEH—58F (8BS ) EiEbric N DFU (Wil 3-1 B ) B NI s i | #% N JF RESET %
i
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& 3-1. HTF3h#A DFU R KR S

o W PAMB Bt , A4 XS AT PK Al PK2 BT,
MCU A\ DFU #z0)5 |, BUE T LUl b0 1 dh g i 5 i AR [E F
3.1.3 GUI R#EFIE#

&R LLFE Chrome. Firefox 5 Safari i & Hrif i DL R #4205 17 GUI @ https://dev.ti.com/gallery/info/
CurrentSensing/INA260EVM_GUI/,

3.1.3.1 B EE

HIR%E GUI :

1. WHORAT T PE R IRBNFE 7 Tl ze 3, DME— DI IES TAE |, 3+ H GUI v] DAYE 2 ZE 5055 EVM &4,
2. WAL EVM fil SCB i 28 s i\ PC , SR )55 BT I GUI 4%,

a. fE¥s SCB #fi N USB i 12 Al , i 5iE EVM CLi%#:F] SCB.
3. 4TJF GUI Composer FiFHFEST , LM ZE I 548 530 GUI (ESRIE 3-2) .
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= Dashboard

INA260EVM_GUI
Version 1.0.0
by CurrentSensing (Group)

GUI for the INA260EVM

(&1 O]

& 3-2. GUI Composer N HEF

a. GUI BT T A A GUIL. T1 21805 F B8 i Al FiRRAS
b. BXE GUI Composer i , i&HRIEFR N4 T/ Cloud Agent A Sa 84 g (15K 3-3 ) o XELHIR
7E 51 README.md 3 iEHE 5 H IR

& 3-3. Tl Cloud Agent

4. (FTHE) TR GUI ML MEA | i A GUI Composer BT R ¥ BIRE |, SRS ILIB IR ERE (15
ZKE 3-2) .

3.1.3.2 GUI & EVM &3
HER GUI ERZE EVM | 515 LU T D IRERAE -

1. ¥&WR 274n ¢ B Fvid B A S 3 GUL.
a. WATRIE B Z AT EVM %H:3] SCB.

2. % README.md SCAFTUEILAS 3 EVM FI GUI 2 [ Ifi%EH: . WRIEE R , GUI 72 F A L & Won SCAR
Hardware Connected.

A& GD a COM7:115200 Hardware Connected.

& 3-4. 4O ER
a. GUI [ Bt s Bor— Mg ade R s a2 0L & SCA DEVICE CONNECTED.
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DEVICE CONNECTED
® INA260
A 3-5. S ER
b. W GUI Fk &7~ Hardware Connected #1 DEVICE CONNECTED , 54 EVM ) RESET $%4f 3
TEIR .

i WSRZE AR |, WA Z Options > Serial Port K i H At A {4 COM ¥ 11 .

Options

TJ, Serial Port ...

& 3-6. B ¥ B AT 0
c. UNSRHEARASRIATIER: , WHATR{E I GUI 1 EVM A& IEFITE IR -
i AR E GUI A EVM LA IER |, MIRTBE 7 20 SCB BB Egmts , an /@177 it v ik
i, AR Z R A A AT Lod i LR e — AN AR R
1. {£ EVM 5 SCB R IIEZ MG T , K% EVM L) RESET 4%4H.
Kl GUI A5 It m] LU Bl g v et i
2. ¥ EVM ZER:3IH AL USB ¥ .
TG fl G AR AT USB #2855 .
R Z G0 PC , A2 HALAR TS TH Y USB ¥ .
3.2 GUI 247

WRIE GUI #EMES | BB D GUI 3% E EVM., A i {E a4 GUI T BLH |, iES R LR L
.

3.2.1 ZRAETF

GUI B3hfa E % %R “Home” itli-k. FMERA IR EIL G | S A8 R T8 (Home) Elbr.

MET L, AU IR 7R GUI 3] EVM R (1§20 GUI £ EVM Z#£) |, & 0] DL e 8 ) #40
Pila) SEH R (E2HE 3-7) .

= £ E L P

F“T‘C“O”a' User Guide Datasheet Schematic E2E Forum
Diagram
& 3-7. ETOET R
3.2.2 FIFEHETF

HEBE MR A | A AN B 4 (FE ) Ebs.  “Registers” ME1iF & 3-8 Fi.
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= INA260 File Options Tools Help

# | Register Map Selected EVM: EVM 1 v | AutoRead  Off v Immediate Write v

Q_ Search Registers by name or address (0x...) [ search Bitfields (% Show Bits
(/) e FieLo View
Register Name Address Value
plalelwlmlmlolalzlalslalzal2[0 0 CONFIGURATION
|~ v Configuration Configuration / CONFIGURATION / RST[15]
| CONFIGURATION o 0x00 0x6127 0 = N0 ORI 0RO ORI OOl 1 | 1 | “1 0] rsT
v Results
CURRENT 0x01 0x0000 0 0 ) Configuration / CONFIGURATION / AVG[11:9]
BUS_VOLTAGE 0x02 0x0000 AVG
POWER 0x03 0x0000 1 v
v Flags and Alerts Configuration / CONFIGURATION / VBUSCT(8:6]
MASK_ENABLE 0x06 0x0008 0 0 0 0 0 O 0 0 VBUSCT
ALERT_LIMIT 0x07 0x0000 00 0 0 0O O 0 0 0 0 0 0O O O 0 O e %
v ID Registers
i —— OXFE 0x5449 Configuration / CONFIGURATION / VSHCT[5:3]
DIE_ID OxFF 0x2270 VSHET
1.1ms v
Configuration / CONFIGURATION / MODE[2:0] ]
MODE
Shunt and Bus, Continuous N

& 3-8. GUI HF e &k

T, T MAE EVM BB G NS arfras . X B T — S B

s f£ “Register” TiTH L , 1§ TN Selected EVM 3% FR 10 5 B A% F (1) 8544 .
- EE, A FE MO ER , e “Configuration” JEI< AR E .
- B RIIEEE , £ MCU i B BRI S ANt | RS20 T 27 7241l , LLE#T “Registers” T
Mo VER, WAREIERENER |, TRt SRR A LR . AP EEBX RSO, £ 0GR 2
A, B e E .
o BUIABOLY , BT MRS B BN, WRTEE | ¥ Immediate Write % & 5 N Deferred Write , LI#
INATER S JG RTF BN
- HP AT LGE I DL — B T E A A ARE
o A Field View #4r  HI/N T HBEE
o A A 7S BRI E R Value
o XGHRARfTERANML
* §TJF Auto Read ¥ A 2 WiH “Registers” T 175 /745 , A28 Results Data 34+ FIETE .
- WERAEWEEEIERE Auto Read kb T4 IR |, AT RES T LA LR T .
o HRAFBRMAERM RS , HikE O B,
- MEXAAERICHE 2N | EEERIER.
o ONTHERN , "L FAE R BERAER , 25 BN EA M F T3S 8. it , W3] File
> Register Data , Wil 3-9 #1fiR.
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File Options Tools Help

’ Program Device... Off v

\J .
# Register Data > B save register settings
terNarnme AUUres

B Load register settings
on

& 3-9. RPN F A HRE

- fEMBEE R 1% T Read All Registers 15l , LA S Br a1 (B 50T &7 A2 458 TUI , AR DN 5 47 4% 53 12
IEZES
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3.2.3 ZREFLTF

5 7 Y — B ) 28 TR A A U 1 27 (4 SBOR ) PR T 310 BoR T 4 B U
M EA RS | HURER I EVM HOSCE | % R TR R TR .

Results to collect/show .
Number of EVMs: 2EvMs v (o) RN o3 @)/ [ ] #Samples Only
VBUS
CURRENT EVM1 SW1:GND v SWO: GND v Delay between samples:
POWER 2.200 ms, [ Auto Delay
EVM 2* SW1: GND v SWO0:vs ~
*Selected EVM SAVE ALL PLOTS CLEAR ALL PLOTS

#Samples: ‘ 1000 ‘

(Changing #Samples clears all plots)

VBUS Result
1V 1V
SIEVH ‘ SAVE PLOT
0.5 0.5
CLEAR PLOT
0 0 Y-Axis Options:
(] Manual Scale
05 05 Max:
Min:
-1 1
0 100 200 300 400 500 600 700 800 900
Samples (995)

B 3-10. ZRTHA B E
N T U “Results Data” 26550 10 AT RN B 55 U M2 AL AN B E -

* Results to collect/show
- AL B SRR M A A H . W AESL N COLLECT DATA ¥l 2 Wi Rk 45 A2 4% , W
TR R BRI, EVM FEREE T A S B S RO B A7 2% (B E T R ) .
- WRHFE EVM RELRREN AP —NRE | BABREAZER , BANRSRELE , MEXRKEES
BEFr. EBTIE R RN
*  Number of EVMs
- ¥ Number of EVMs i 3¢ B4 B A 4|1 /EFH 1) EVM £ & .
c EHZNE 2-2, THEWTEZA EVM SR K.
o EMAFEMUZEER , B4 FE K “Configuration” iE-E AR E .
- GUI =ik &ZAUSZHF 4 4~ INA260EVM.
- Switch settings
o AR E I N EVM IR b
o fEGUI FEFREE , MESEMNEER EVM B REF—2
- EVM 1 B3AER SRR, BRIFCSEREMNRE.
- RS SGZ I ER , AT “Configuration” JETR AR FRIBEE
o INEEHZA A ) “Registers” il “Configuration” &5+ _EAF I Ek EVM 554 BR 25 ().
- HNUER EVM BIJFIRER |, 2R EVM BN TE R EVM.
o IREIRREE
- Collect Data
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» %N COLLECT DATA ##5 T tEF 535 .
o fEHEESCT , MCU ji@it USB BULK JliE S BRI AR Al 8 RAE . 3 — AN prE 25
KRG, HARSIUN — et
- JFTH EVM A & RAEILFER N — A “FEARSE” .
BIRTERAERARIN | AT LU “Registers” G -R 6 HAB 2 AE 28 0EAT LS | (HIX 2 08 it R4 1)
FEIR S [H] o
* % STOP COLLECT %4115 1 R AE B4
- #Samples Only
WG T BN |, GUI 7R RENFEASEILS] “#Samples” HEHF TR EMEEE , BT IEREL
i
o WMRRIEFZEIEHE | GUI Gk RAE G HAUAE i BT #Samples MEA
- Delay between samples
B BN FEARE R I AR (7] 2 [ [ RER .
R AE IR I A A TS UG A (R T 2R 4 R AR . EVM B DL EH R CPU ) |, WIEiEEIR1G I
7 B ZEIR B[R]
BARERGEHIEN | AP T LUEE “Registers” IR X HAR G AE 28 FAT LS | (HIX 2238 e kAR 1)
FEIR S [A]
- Auto Delay
FRPE AR 0] SPIE AN B A e il E R | I AEIR
WAL Z A EVM |, TIZEIRAE A 461 N IR SR B T 0H 5T 2B R {E 5 /M) EVM.

- Save All Plots
% F SAVE ALL PLOTS ##417] LI¥4 Results to collect/show 43 W RN 24 1T ik &5 5o0f M 1 B 5 A7 21
HL TR b o
R EAEE 5101 SAVE PLOT #2411, WIACK Z I 2 b I BHE R AE Rk .

- Clear All Plots

* % CLEAR ALL PLOTS & I {5 B BT A B3R ) 3

N R 55141 CLEAR PLOT 241 I A5 b 1% 1 26 b i 500808

- #Samples
B A () B P R B R SR R AL
- WEUHEESIE T ERGAT , DMELE T U IS BRI .

- Y-Axis Options
Manual Scale
- NS I BRI T EVM 25 RN “Max” Fil “Min” B8 e AR [F AR FEAE -
- WERARIE R IERAE |, B EVM B B B Y BiAREE  BAREGRTZ% EVM ER SRR R

B/ ME A B KAE

Max
- WEFRFYHTHA EVM B K Y HiE.
- & “Manual Scale” J5 , WIRILFB A, KRS B 30 78 EER A 2S00 10 5 K E -
Min
- WEERFHTIE EVM /N Y i
- 1% Manual Scale J5 , iR LFBOAZ | WIEIZRS A 3NIHE 7 EIR S 451 & /ME.
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3.3 EVM USB BHE5&/5

WA, \IAMER GUI, l_Ji USB it I EL#% 5 EVM #EATEME . AT 0 |, il 8547 COM i U AIE P&
A, R s COM i M5 USB BULK il #i 4 R XA BTl 5 e LK E .. A GUI iE
2 EVM.

3.3.1 £5/£ USB £ 5#/F
18 F H3 47 COM 3 3@ LA RS 1) USB #4355 & 778 -

o WEBEFHNER X ;- setdevice DEVID
- Hrb setdevice $hZN/NE |, F:H DEVID E XA -
o kR AL 4 A LSB i, xbF ik Ox4A , A 10.
- R, WREER T —AEEZ A EVM R E AL SCB , Mk BRI R B K ek ik
* SCB {ERFNIN AR G 12C 80 SPI. R AERAEMEEAE |, WEEFERIAN SPI. fE%$: 12C EVM
KI5 R &AL SCB, LMEH 12C.
- i, EikE INA260 @ﬁﬁ%ﬁ%ﬁﬂﬁhﬁ Ox4A , Ki%#n4 : setdevice 10.
- XHFAH , EVM £z [A] JSON &I HARDIRES (- “idle” B¢ “collecting” ) :

{"acknowledge":"setdevice 10"}
{"evm_state":"idle"}
o AR rreg ADR
- Hr ADR £t/ gkl | rreg tH4N/INE
- TSR K EBNG | FFEATEELL “0x” FFk. AT DUEEH 0 SRIEAN G as bk, Bl | 2
T EU A A7 Ak 0x02 , — 2645 3y g & A4
* rreg 2
* rreg 0002
* rreg 0x02
- M “Ox” B, “x” BAUNNE.
- XA, EVM iz [E] JSON A% AL RATIRE (- “idle” B “collecting” )
{"acknowledge":"rreg 0x02"}
{"register":{"address":2,"value":2637}}
{"evm_state":"idle"}
© HAFAEHEEA - wreg ADR VAL
- Jirh ADR A1 VAL SR +758E] , wreg 1h% /NS
- AAERRHIEEAME P LR RS8N | FEHATRELL “Ox” ko tnPLESEEA 0 SRIEANZF 1725 H bk FIME
it Ein) F A7 AR Ox0 5 ANMH 0x436f , JELeq7 21 fir (04 -
* wreg 0 436f
* wreg 00 0x436f
* wreg 0x00 0x436F
- fEM COx” I, X AN
- XFAP, EVM iR A JSON feaU £ AR (- “idle” i “collecting” )
{"acknowledge":"wreg 0x00 0x436f"}
{"console":"Writing 0x436f to CONFIGURATION register"}
{"evm_state":"idle"}
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3.3.2 1511 USB BULK 318 REH#E

Collect Data ht ~ARYE 1R E NI BCE | BT A R A7 28 ROEAHICHR - LD REAEE S Bt U P e i
f, EARNERE EVM BUH RIS 4 I E . SUERBEE 4 47 COM I LR sh iz Ik, {Hilid USB BULK
B AIELE R BB , W B #EL

o EEEIERAEMR L collect timerPeriod collectFlags channelAddressIDs numDevices
- WEERRA NS EATER , HHBANSHI UL FERRRE | ST

timerPeriod

- MCU mH T HHR AL T 284838 (B4 s, 7S 32 ffh ) -

collectFlags

- RAELLFE S, — MR RA 1 (R EBEREA FAAAHEEA ) 10 ( R T4
EHRA) -

VSHUNT = 0b1000
+ VBUS = 0b0100
CURRENT = 0b0010
POWER = 0b0001
channelAddressIDs
- XL LSB kA 12C Hiuhilk sk 4 4> LSB.
B, i EVM 1 #E#3E 0x41 |, EVM 2 73858 0x43 F |, iX B f)4E k2 0600110001
NumDevices
- HERRK EVM & (1-4).
- BN, EEE 2.2ms FFUEHEAT — X VSHUNT #1 VBUS #8505 gE |, IXHF EVM 1 ik = 0x41 F1 EVM 2 Mk
= 0x43 1> INA260EVM , &% : collect 2200 12 49 2.
SHFA] , EVM £33k 1] JSON #% AR AANRE

{"acknowledge":"collect 2200 12 49 2"}
{"evm_state":"collecting"}
- USB BULK i 8 an M A& 2UHI % - framelD deviceNumlID address registerSize data
NS AR EoRE , T
- framelD (1 577
IRZTLN 0. H T B IEEE CX 5.
- deviceNumID ( 1 F71)
XFRET EVM % 51 1D $5-
- fE BB, R AR E D 0x41 1) EVM 1 328, B8R N 1, R E
0x43 ff] EVM 2 B2, iZA6H N 2.
address (1 MF75)
NS AL ) B A
- registerSize (1 N7 )
Je THHE B 7 T 8
- data (—&K 1 AT
TR FHAHREARE |, Hafmm AT,
o IEHERERENE R - stop
- Hrp stop th%N/NE .
- EVM iZ[H] JSON #% i ARLIRE

{"acknowledge":"stop"}
{"evm_state":"idle"}
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4 TR
4.1 FEE

Kl 4-1 FE 4-2 275 7 INA260EVM HJJEERE] . & 4-1 Box 7 EVM HIHLES .

Kl 4-2 7R T EVM BB RIALR

+3V3 P12
D1 +3v3
‘ pD2 B R8 +3V3
ALERT
R4 Ky —Lc1 —ch (B 4.7k
210k 1uF 0.1uF TP3 D2
VS _R7 K R2
10k P8 1.0k
¥,
¥
= SDA PN4
GND SWo
+3V3 = 1 _
U1 +3V3  GND
2 —
(‘3——_|_ 10 1 ys NI R1 s
= 1 8 P9 10k
(%——| GND VBUS VBUS SDA 4
™20 TP1 1 9 PN5
3 1 IN- F e s SCL PNA_ 5 |
1 31 e TP10
20 |2 A0 PN5 6
14 4
3 15 :: AL TP11 7 | MNT 1
8_ If TP4é 16 |\ Al 8 | MNT 2
IN+ 5 =
GND MNT_3
it ETH Ve GND 10 | vNT 4
=  CUS-14TB
INA260AIPWR GND
Sswi
= 1
+3V3  GND
J3A  13B 2 1
T
PQ1 3
sy - |
2 PQO 4 { 4
2 oo - - - =
+3v3 — 4 3 PQ2 GND PN4 5
T__enD 6 8 8 5 i é 1 PD2_A
7 > PD2B
Ezé Blg 8 8 ; PQ3 A - PD2_A e | 2 P02E PN5 6
N4 12 [ 5 Slu PPO E ﬂ PNS SH-J1 14 7 | wNT 1
8 MNT 2
PP | by | b P4 21 MNT 3
MNT_4
—=  CUS-14TB
GND
&l 4-1. [ 2 K] B g
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BBt XA

H3 H5 Hé

SJ5382 SJ5382 $J5382

X X X

PCB PCB

LOGO LOGO

Texas Instruments CE Mark FCC disclaimer
LOGO1

CAUTION HOT SURFACE

Variant/Label Table

LBLL Variant Label Text
PCB Label 001 INA226EVM

THT-14-423-10
Size: 0.65"x0.20 "

771

Label Assembly Note
This Assembly Note is for PCB labels only

772
Assembly Note
These assemblies are ESD sensitive, ESD precautions shall be observed.

773
Assembly Note
These assemblies must be clean and free from flux and all contaminants. Use of no clean flux is not acceptable.

774
Assembly Note
These assemblies must comply with workmanship standards IPC-A-610 Class 2, unless otherwise specified.

275
Assembly Note
Trim the leads under J1 (back of PCB) to give clearance from surface

& 4-2. 1R A

PCB
LOGO
WEEE logo
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4.2 PCB i [

FEL AR AT R AT 2R 4 EU ) o . X LE ] B AE o RS AR B AT R, T AN T#li& EVM PCB.
4-3 2 4-6 #i%4: T INA260EVM [) PCB 2.

@ 15a MAX [ )
36UCM MAX .

&l 4-4. TH 2

& 4-5. AL 4-6. X2
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BBt XA

4.3 YIRHE #

% 4-1 #2417 INA260EVM IS5 5,

x 4-1. YRlER

(A=) HE Zi=A L] HES*E BHERS palbea:
IPCB1 1 El il i, AR INA260EVM AR
C1 1 1uF | HES, BE , 1uF , 16V, +/-20% , X5R , 0402 0402 GRM155R61C105MA12D MuRata
C2 1 0.1u |HZLY, B@& , 0.1uF , 50V, +/-20% , X7R , 0402 0402 GRM155R71H104ME14D MuRata
F
D1. D2 2 Hfy |LED, At , SMD 0805 VAOL-S8WR4 Visual
Communications
Company, LLC
H1. H2. H3. H4|4 Bumpon , ERFE |, 0.25 X 0.075 , i&H] 75x250mil SJ5382 3M
J1 1 i 7 Ek 6POS T 46 A\ 5MM PCB ZH35 i+ = - %18 Z2Z5 1585 5| £k HDR6 691137710006 Waurth Electronics
J2 1 #EiME , 2mm , 6x2 , 4, RIA, TH $HEE , 2mm , 6x2 , NPPN062FJFN-RC Sullins Connector
R/A, TH Solutions
J3 1 EERSk , FIL, B, 1242, 0.079" (2.00mm) HDR12 NRPNO062PARN-RC Sullins Connector
Solutions
J4 1 Bk, 2.54mm , 2x1, 4, TH B3, 2.54mm 61300211121 Wurth Elektronik
2x1, TH
R1. R2 1.0k |HFH , 1.0k , 5% , 0.063W , 0402 0402 CRCWO04021K00JNED Vishay-Dale
R4. R7 2 10k | #iFH , 10k , 5% , 0.063W , AEC-Q200 0 %% , 0402 0402 CRCWO040210KOJNED Vishay-Dale
R8 1 4.7k |, 4.7k , 5% , 0.063W , AEC-Q200 0 % , 0402 0402 CRCW04024K70JNED Vishay-Dale
SH-J1 1 Sriiés . 2.54mm , &, B Syiias , 2.54mm 60900213421 Waurth Elektronik
f*
SWO0. SW1 2 WEhFFE SPAT FHG%: | HA SMT_SW_11MM3_4M | CUS-14TB Nidec Copal
M1 Electronics ( H/=F}
EHFAMRAF )
TP1. TP2. 12 WA, A, SMT Testpoint_Keystone_ 5015 Keystone
TP3. TP4. Miniature
TP5. TP6.
TP7. TP8.
TP9. TP10.
TP11. TP12
u1 1 AL AR CRAE L PH I sl A &, B 12C A E DR F iR A Th R - | PWOO016A INA260AIPWR BN (T1)
#% , PW0O16A (TSSOP-16)
C3 0 01u %A, W& ,010F, 100V, +/-10% , X7S , AEC-Q200 1 % , 0603 0603 CGA3BE3X7S2A104K080AB | TDK
F
FID1. FID2. 0 BEAEbR L. WOH T BB R T AN H A& ANiEH
FID3
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R 41 PRNER (42)
(VA2 HE PiBH HHIESH BARE ialbeed]
LBL1 0 AFEENFTEIRRZ |, 0.650" ( %% ) x 0.200" ( & ) - 10,000/ PCB #5% , 0.650 x THT-14-423-10 Brady
0.200 #~}
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5 HARE R

5.1 BtR
BT A B8 9 355 B AT & B

6 TEM LA (T1) FRALHIAH O

A PR AN T Wubk3kAS , kg5 SBOU307 . BN 2 SCHik g -5 AAT AR - BEXT BT 458 5 A SRS I B B
HOCRMEIT R . BOHT BT AT A wwwe.ti.com _E3RTF , AT AAEINASCES (TI) SCrkma S Aacy (L&A (800)
477-8924 ) 5= b5 Bty ( FLIE N (972) 644-5580 ) 3K1F. 1TIARS , AT SCR bR B SCER GRS R SR . 3R
6-1 %t 75 EVM FHCHI SO . v BUEEE i3k 6-1 HR R UE 215 5. 2R 2 www.ti.com |
(77 28 SCPE S8 . SOk 5 B #:21) PDF XY .

2 6-1. HH RS
AR S SCERGR S
INA260 %i#fE£ SBOS547
INA260-Q1 ¥# 3% SBOS743
LGRS E YN SBOA511
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ERFRNRREH
THERHFREEEARNTEMELE (8FRER ) . RUTAR (8F2E)1) . MARHEMRTTEN, METE, R22EEMEMER ,
FRIEXAREETREEMATRERNER , SFETR T EH Y., EREARFENER SR FRIBEME =5 MR=RNHERIE
XEFRAEER T @B RITORETRAREA, SFBTREUTE2HRE : (1) HNENNARFESEN TIF R, (2) ®it. B
EHMREHNEA |, (3) BRENNABRZEMMEUAREAEMIERZS, FERE, KERHMER,
XLEFRRMELE  BFZTEH, TI BRENTRXLERRATHARETFEARN TI ~ROMA, FPENXERRHTHBEFHRER.
BEREAEMEM TI DIRFRNBEFAE=F DR, ENEFBRZREXERFNEATY TI REARERNDEARE, B/E, K
K, HENKES , T HEBEFAR.
THRENTRZ T HEERRR ticom LEMBARAZRT FREMHEMEAZTOHIR. T REXERRATLT RIUARMESNER
THEX TIFREARHERNERIIBRETFH.
Tl 33 H B BT RER M E M H AR T RS & .
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